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About this document
Purpose and audience

This document provides information about setting up and using the 
Meridian SL-100 network management system for SPECTRUM. It is 
intended for personnel involved in maintaining the Meridian SL-100. 
Previous knowledge of the Meridian SL-100, the MicroFrame Sentinel 
2000 system, and the Cabletron SPECTRUM system is assumed.

Structure
This document contains the following sections:

• Introduction – introduces the Meridian SL-100 network 
management system for the SPECTRUM Enterprise Manager.

• Physical connections – explains system requirements and 
physical hardware connections of the Sentinel 2000 and the 
SPECTRUM systems configuration.

• Software configuration – describes the software installation and 
configuration for the Sentinel 2000 and the SPECTRUM systems 
configuration, as these requirements relate to the Meridian SL-100.

• Getting started – provides procedures to help you get started with 
the Sentinel 2000 and the SPECTRUM systems.

• List of terms – contains acronyms and abbreviations of terms used 
in this document.

How to check the version and issue of this document
The version and issue of the document are indicated by numbers (for 
example, 01.01).

The first two digits indicate the version. The version number increases 
each time the document is updated to support a new software release. 
For example, the first release of a document is 01.01. In the next 
software release cycle, the first release of the same document is 02.01.
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x About this document
The second two digits indicate the issue. The issue number increases 
each time the document is revised, but re-released in the same 
software release cycle. For example, the second release of a document 
in the same software release cycle is 01.02.

References in this document
This guide references the following documents:

• Some procedures in this book may also refer to the Alarm and 
Performance Monitoring Procedures. Meridian SL-100 customers 
should refer instead to the Meridian SL-100 Alarm Clearing 
Procedures.

• Meridian SL-100 Systems Log Report Reference Manual, 
555-4031-8401

• Meridian SL-100 Product Guide, 555-4001-103

• Meridian SL-100 Ethernet Interface Unit on LPP Services Guide, 
555-4001-024

• Input/Output Devices Maintenance Guide, 297-1001-590

• Meridian SL-100 Customer Data Schema, 555-4031-851

• Meridian SL-100 Enhanced MAP (EMAP) Workstation Product 
Guide, 555-4001-012

Cabletron Systems, Inc. documents:

• Getting Started with SPECTRUM

• SPECTRUM Guide to Integrating Applications

• SPECTRUM Installation Guide

• SPECTRUM on-line help

MicroFrame Systems, Inc. documents:

• Getting Started for the Sentinel 2000, Installation Guide

• MicroFrame Installation Guide for the Sentinel 2000

• MicroFrame User Guide for the Sentinel 2000

FOR MORE INFORMATION

To determine whether you have the latest version of this 
document and how documentation for your product is 
organized, check the release information in the Meridian SL-100 
Master Index of Publications.
555-4001-027   Standard   01.05   April 2002  
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Introduction
Understanding the Sentinel 2000 and SPECTRUM systems

The Meridian SL-100 network management system for the 
SPECTRUM Enterprise Manager (hereinafter referred to as the 
SPECTRUM system) is a network management system for the 
Meridian SL-100. It is comprised of third-party software and hardware 
providing a fully integrated network management system in a graphical 
user interface (GUI) environment.

The Meridian SL-100 terminal/printer port is connected to a host port 
on the Sentinel 2000 system to transmit log reports. The Sentinel 2000 
system maps these logs to Simple Network Management Protocol 
(SNMP) messages called traps. These SNMP traps are sent by the 
Sentinel 2000 SNMP proxy agent to the SPECTRUM system.

The SPECTRUM system provides fault isolation and alarm 
interpretation capability in a GUI environment. A telnet session to the 
on-switch Meridian SL-100 maintenance and administration position 
(MAP) is used to resolve alarms on the Meridian SL-100. Alarms and 
system status are indicated by changes in icon appearances in the 
SPECTRUM system GUI. The icon representing the Meridian SL-100 
is labelled MSL100 in the SPECTRUM GUI. The network manager 
selects the alarm-signaling icon and, by navigating through the GUI, 
determines the location and nature of the alarm. Once the alarm is 
analyzed, a telnet session to the MAP is launched from the icon to 
perform system management functions on the Meridian SL-100.

This chapter introduces the Sentinel 2000 system and the SPECTRUM 
network management system as it relates to the Meridian SL-100. 
Refer to the appropriate manufacturer’s documentation for detailed 
information about each system.
Meridian SL-100 Network Management for SPECTRUM User Guide



12   Introduction
Benefits
While the Meridian SL-100 has a MAP management system, there are 
several advantages to using the Sentinel 2000 system and the 
SPECTRUM system:

• GUI environment to aid in network monitoring and fault isolation as 
opposed to a text-based system.

• All alarms for every system level are easily accessible, minimizing 
the time spent looking for the alarms.

• Switch system management is integrated with other systems in one 
environment.

Hardware components
The Sentinel 2000 system and the SPECTRUM network management 
system for Meridian SL-100 consists of three major components:

• Meridian SL-100 switch

• Sentinel 2000 system (by MicroFrame, Inc.)

• One or two Windows NT computers running Cabletron Systems, 
Inc.’s SPECTRUM software:

— SpectroSERVER 

— SpectroGRAPH 

The Sentinel 2000 system configuration is factory-customized to 
accommodate an interface between a Meridian SL-100 and the 
SPECTRUM network management system. Figure 1 on page 13 shows 
the logical data flow between the Meridian SL-100, the Sentinel 2000 
system, and the SPECTRUM network management systems.

Meridian SL-100 switch module
Meridian SL-100 logs are sent to the Sentinel 2000 system over a 9600 
baud modem dial-up, or direct, connection to the terminal/printer port. 
Once the logs are processed and events are generated and displayed 
in the SpectroGRAPH GUI, system management functions using a 
MAP terminal can be performed. The MAP terminal is accessed from 
the SPECTRUM system GUI by means of a telnet session to the 
Meridian SL-100. Telnet access over ethernet to the Meridian SL-100 is 
provided using an ethernet interface unit (EIU) or a single shelf link 
peripheral processor (SSLPP).

For more information about the EIU and LPP, refer to the Meridian 
SL-100 Ethernet Interface Unit on LPP Services Guide. For MAP 
terminal information, refer to the Meridian SL-100 Enhanced MAP 
(EMAP) Workstation Product Guide.
555-4001-027   Standard   01.05   April 2002  



Introduction   13
Sentinel 2000 system module
The Sentinel 2000 system is operated and administered using a 
command line interface on a dumb terminal, or PC with terminal 
emulation capability, through an auxiliary port connected to a LAN.

The Sentinel 2000 system post processor receives logs, performs the 
log analysis, and generates traps to the SPECTRUM system by way of 
the SNMP proxy agent. The SNMP proxy agent provides the interface 
to the SpectroSERVER system.

Figure 1
The network management system logical data flow
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14   Introduction
The system operator can use the Sentinel 2000 system to monitor logs 
processing and other system events including SNMP traps sent to the 
SPECTRUM system.

For detailed information on the Sentinel 2000 system operation, see the 
User Guide for the Sentinel 2000.

SPECTRUM system module
SPECTRUM system is based on client/server architecture. The client, 
called SpectroGRAPH, provides the GUI that displays icons, alarms, 
and alarm status for managing the network. The server, called 
SpectroSERVER, provides the database, security, device modeling 
capabilities, and device management functions.

Configuration and management of the Meridian SL-100 is 
accomplished in two ways:

• by launching a telnet session from the MSL100 icon on the 
SPECTRUM system GUI to the Meridian SL-100 or

• by launching a telnet session from the MSL100 icon on the 
SPECTRUM system GUI to a terminal server with a connection to 
an Meridian SL-100 terminal/printer port.

For detailed information about the SPECTRUM system, see Getting 
Started with SPECTRUM and other Cabletron Systems documentation.

General steps for system setup and operation
First, setup the hardware according to “Physical connections” on 
page 15. That chapter explains system requirements (minimum and 
recommended) for each module and it explains hardware connections.

Second, configure ports, install any software required, and begin initial 
logs distribution using “Software configuration” on page 19. That 
chapter explains the steps to install Meridian SL-100 model type files 
on the SPECTRUM system, datafill Meridian SL-100 tables, and 
configure software specifically for Meridian SL-100 working with the 
Sentinel 2000 system and the SPECTRUM system.

Finally, operate the systems to aid in Meridian SL-100 network 
management using “Getting started” on page 31. That chapter explains 
how to create a new Meridian SL-100 model, establish a connection to 
the MAP terminal, and manually clear alarms in the SPECTRUM 
system.
555-4001-027   Standard   01.05   April 2002  
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Physical connections
This chapter describes system requirements and physical hardware 
connections of the Sentinel 2000 and the SPECTRUM systems 
configuration. Nortel Networks provides minimum requirements for 
installation and operation (unless otherwise indicated). Figure 2 shows 
an example for connecting the Meridian SL-100 to the SPECTRUM 
system, Sentinel 2000 system, and the LAN.

Figure 2
Sentinel 2000 cable connections (modem direct connection)
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16   Physical connections
See the SPECTRUM Installation Guide, the MicroFrame Installation 
Guide, the MicroFrame User Guide, and other appropriate 
manufacturer’s documentation for detailed instructions about setting up 
individual system hardware and software.

Meridian SL-100 system requirements
The Meridian SL-100 requires:

• MSL05 (or above) software

• Input/output controller (IOC) terminal/printer port with an optional 
9600 baud modem

• EIU resident on the LPP (for telnet option); or

Single shelf link peripheral processor (SSLPP) with an enterprise 
LAN connection and an assigned IP address

Sentinel 2000 system requirements
In the Sentinel 2000 and the SPECTRUM systems configuration, the 
Sentinel 2000 system requires:

• factory-installed Meridian SL-100 post-processing routine (log 
parser) with Meridian SL-100 alarms filter

• SNMP proxy agent with Nortel Networks trap format support

• 9600 bps baud modem to analog line (for dial-up to the Meridian 
SL-100 terminal/printer port)

• RS-232C cable (for modem connection)

• telephone cords with RJ11 connector

• network cable with an AUI or 10 Base-T connector (furnished with 
ethernet card in Sentinel 2000) with an enterprise LAN connection

• assigned ethernet address for network applications (furnished with 
ethernet card in Sentinel 2000 system)

• assigned IP address (for network applications)

• local terminal, or PC running a terminal emulation program, (used 
to initialize and administer the Sentinel 2000 system using the Aux 
port). The terminal must have a standard RS-232 (serial) interface 
for connection to data communications equipment. Use the 
following terminal settings:

— asynchronous

— 9600 bps

— 8-bit character length, one stop bit, no parity

— XON/OFF (software) flow control
555-4001-027   Standard   01.05   April 2002  
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SPECTRUM system requirements
Cabletron Systems, Inc. offers several system configurations for the 
SPECTRUM system. The SpectroSERVER and SpectroGRAPH 
system components can be installed on the same or separate 
platforms. In the Sentinel 2000 and the SPECTRUM systems 
configuration for the Meridian SL-100, the SPECTRUM system 
(SpectroGRAPH and SpectroSERVER) requires:

• LAN connection – Enterprise LAN connection for each platform 
running either SpectroSERVER or SpectroGRAPH workstations.

• SCSI drive – Cabletron Systems, Inc. recommends running the 
SPECTRUM system only on platforms with SCSI drives.

• 96 MB of RAM for SpectroSERVER workstations or 64 MB for 
SpectroGRAPH GUI workstations (minimum recommended).

• 1 GB of disk space for SpectroSERVER workstations or 500 MB for 
SpectroGRAPH GUI workstations (minimum recommended).

• CD-ROM drive (for loading the SPECTRUM system).

• 1024 x 768 PCI bus video card supporting 256 colors or 8-bit color 
with at least 2 MB of DRAM.

• 17-inch color monitor for workstations running SpectroGRAPH 
software.

Physical hardware connections
Physical cable connections depend upon the type of system 
configuration selected. The configurations described in this section are 
an ethernet LAN connection and a modem direct connection to the 
Meridian SL-100.

Note: Since it is not practical to describe all possible configurations 
or all possible connections for each, consult your Nortel Networks, 
MicroFrame, or Cabletron Systems support representative to 
determine the best configuration for your system.

Figure 2 on page 15 shows the ethernet LAN connection and the 
modem direct connection to the Meridian SL-100 from the Sentinel 
2000 and the SPECTRUM systems.
Meridian SL-100 Network Management for SPECTRUM User Guide



18   Physical connections
Meridian SL-100 cable connections
Cable connections from the Meridian SL-100 are as follows:

• Connect the Meridian SL-100 IOC terminal/printer port to a host 
port on the Sentinel 2000 system using an RS-232 direct cable; or

For a modem configuration, connect the host port on the Sentinel 
2000 system to the Meridian SL-100 IOC port using 9600 baud 
modems and analog lines.This connection supports logs transfer to 
the Sentinel 2000 system.

• Connect the EIU LPP or the SSLPP to the enterprise LAN where the 
Sentinel 2000 and the SPECTRUM systems are connected.

See the Meridian SL-100 Product Guide, for detailed information about 
Meridian SL-100 cabling requirements and connections.

Sentinel 2000 system cable connections
Cable connections from the Sentinel 2000 system are as follows:

• Connect the PC or terminal to the Aux port – This connection is 
used to initialize the Sentinel 2000 system and can be disconnected 
after the Sentinel 2000 system is initialized.

• Connect the Meridian SL-100 IOC terminal/printer port to a host 
port on the Sentinel 2000 system (to direct logs to the Sentinel 2000 
system) using an RS-232 direct cable; or

For a direct modem configuration, connect the host port on the 
Sentinel 2000 system to the Meridian SL-100 IOC port using 9600 
baud modems and analog lines.

• Connect the Sentinel 2000 system internal modem(s) to analog 
telephone line(s) for remote Sentinel 2000 system support.

• Connect the Sentinel 2000 system to the enterprise LAN either 
through the AIU or 10 Base-T connector.

See the MicroFrame Installation Guide for Sentinel 2000 for detailed 
information about the Sentinel 2000 system cabling requirements and 
connections.

SPECTRUM system cable connections
The SPECTRUM systems (SpectroGRAPH and SpectroSERVER) are 
connected to the Ethernet LAN. See the SPECTRUM User Guide for 
detailed information about the SPECTRUM system cable connections.
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Software configuration
This chapter explains the software installation and configuration for the 
Sentinel 2000 and the SPECTRUM systems configuration as these 
requirements relate to the Meridian SL-100. These procedures assume 
the SPECTRUM system is installed and fully operational.

See the SPECTRUM Installation Guide, the MicroFrame User Guide, 
the MicroFrame Installation Guide, and other appropriate 
manufacturer’s documentation for instructions about installing 
hardware and software for these systems.

The Sentinel 2000 and the SPECTRUM systems software configuration 
for the Meridian SL-100 includes:

• installing the Meridian SL-100 management module on the 
SPECTRUM server system (SpectroSERVER)

• installing the Meridian SL-100 model type on the SPECTRUM client 
system (SpectroGRAPH)

• configuring the Meridian SL-100 terminal/printer port (datafilling 
table TERMDEV)

• configuring the Meridian SL-100 permanent log distribution 
(datafilling table LOGDEV) (optional)

• configuring software on the Sentinel 2000 system

Installing the Meridian SL-100 management module on the 
SpectroSERVER system

The Meridian SL-100 management module must be installed on the 
SPECTRUM SpectroSERVER and SpectroGRAPH systems. The 
Meridian SL-100 management module defines the Meridian SL-100 
model type.
Meridian SL-100 Network Management for SPECTRUM User Guide



20   Software configuration
The Meridian SL-100 model type (defined by the Meridian SL-100 
management module) includes definitions of common switch attributes, 
the MSL-100 icon, and available menu options. The Meridian SL-100 
model type is used to create models in SpectroGRAPH of Meridian 
SL-100s in the network.

These Meridian SL-100 models are represented by icons in the 
SpectroGRAPH GUI. Operators monitor and manipulate these icons to 
accomplish network administration.

Use Procedure 1 to install the Meridian SL-100 management module 
on the SpectroSERVER. This procedure describes installation using a 
Windows NT computer CD.

Note: This procedure assumes SpectroSERVER and 
SpectroGRAPH have been installed and are functioning. If these 
components have not been installed, see Cabletron Systems 
documentation to install the SPECTRUM system before continuing.

Procedure 1
Install the Meridian SL-100 management module on the 
SPECTRUM system

1 Place the MSL-100 MM CD in the CD ROM drive.

2 Start SPECTRUM from the Start/Programs menu.

This starts the SpectroSHELL software.

3 At the SpectroSHELL prompt, Start the installation program by entering:

drive:/MMinstall

where

drive is the CD ROM drive on the computer.

Example: d:/MMinstall

4 At the extraction key confirmation request prompt, click OK.
Note: If the installation program prompts a request for the extraction key, enter the 
SPECTRUM extraction key.

5 When the SPECTRUM Host Evaluation window displays, verify the physical 
memory and swap space requirements and click OK.

6 When the Installation Configuration window and the Component 
Configuration subwindow displays, click the Select all SpectroSERVER 
components check box to install management modules for SpectroSERVER 
only.

7 Click the Select all SpectroGRAPH components check box to install the 
SpectroGRAPH management module on this same computer.

8 At the Installation successful prompt, click OK.

This procedure is now complete
9 Click Exit to exit the installation.
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Meridian SL-100 configuration
This section describes the logs distribution to the Sentinel 2000 and the 
Meridian SL-100 datafill and maintenance operations for the Meridian 
SL-100 terminal/printer port connection.

This procedure requires access to the Meridian SL-100 maintenance 
and administration position MAP CI, TABLE EDITOR, and LOGUTIL 
utilities. Only table datafills specific for the Sentinel 2000 and the 
SPECTRUM systems configuration are explained here. For more 
information about datafilling tables, see the Meridian SL-100 Customer 
Data Schema.

Datafilling table TERMDEV
Use the TERMDEV table to setup the input/output controller (IOC) port 
for the Sentinel 2000 system connection. Table 1 describes datafilling 
table TERMDEV in the Sentinel 2000 and the SPECTRUM systems 
configuration.

Table 1
Table TERMDEV

Field Entry Sample data Explanation and action

TERMDES 1 to 8 
alphanumeric 
characters

S2k Terminal designation. Enter the name for each 
terminal device.

IOCNO 0 to 19 2 Input/output controller number. Enter the number 
of the IOC to which the terminal device is assigned. 
Valid entries are from 0 to 19.

CKTNO 0 to 35 15 Input/output controller circuit number. Enter the 
IOC circuit number to which the terminal device is 
assigned. Valid entries are from 0 to 35.

TERMTYPE alphanumeric VT100 Terminal type. Enter the terminal type. Valid entries 
are HAZ, LSG, VUC4, KSR, PRT, HP, VT100, 
VT102,TEC, CYB, SPRT, FPRT, DPH, and SMDI.

BAUDRT alphanumeric B9600 Baud rate. Enter the baud rate of the terminal 
device. Valid entries are: B110, B134PT5, B150, 
B300, B600, B1200, B1800, B2000, B2400, 
B3600, B4800, B7200, B9600, and B19200.

INTYP alpha EIA Interface type. If the terminal device is equipped 
with a data set or modem, enter EIA (Electronic 
Industries Association interface). Otherwise, enter 
CL (current loop).
Meridian SL-100 Network Management for SPECTRUM User Guide



22   Software configuration
Figure 3 shows an example MAP display depicting the datafill for table 
TERMDEV.

Figure 3
MAP display example for table TERMDEV

Meridian SL-100 terminal/printer port maintenance
Procedure 2 on page 23 shows how to maintain the terminal/printer 
port using the MAP terminal.

EQPEC alphanumeric 1X89BB Equipment product engineering code (PEC). Enter 
the PEC of the terminal controller circuit card. Valid 
entries are: 1X67AA, 1X67AB, 1X67AC, 1X67BC, 
1X67BD, 1X67CA, 1X67CB, 1X67FA, and 
1X89BB.

PRTY See subfield. NONE Parity. Enter the parity of the terminal device. Valid 
entries are ODD, EVEN, and NONE.

GUAR Y or N N Guaranteed device. Enter Y if the device is 
guaranteed to run despite the call processing or 
maintenance load. Enter N if the device is not 
guaranteed. The default is N.

MODEM NONE, 
DBANS, CTS, 
RIXON, and 
UDS

NONE Modem type. Enter the type of modem that 
corresponds to its connecting port. Valid entries 
are NONE, DBANS, CTS, RIXON, and UDS.

COMCLASS ALL Command class. Enter the command class allowed 
for the terminal device. Valid entries are from 0 to 
30, NONE, and ALL.

Note: A user logged in at the terminal is permitted to 
execute only those commands that are allowed on the 
terminal and for the user’s login ID.

CKERDISC Y or N Y CkEr alarm on DISconnected device. Enter Y if the 
device will cause a CkEr alarm whenever it is in a 
DISconnected state. Otherwise enter N.

Table 1
Table TERMDEV (Continued)

Field Entry Sample data Explanation and action

TERMDES IOCNO CKTNO TERMTYPE BAUDRT INTYP EQPEC PRTY GUAR MODEM COMCLASS
                                                              CKERDISC
________________________________________________________________________
S2Kdial   2    15    VT100  B9600    EIA 1X89BB NONE   N   NONE    ALL

                                                                 Y
555-4001-027   Standard   01.05   April 2002  



Software configuration   23
Procedure 2
Maintain the terminal/printer port using MAP

At the MAP terminal command interpreter prompt

1 Access the IOD level of the MAP display by entering:

>MAPCI;MTC;IOD

and pressing the Enter key.

Example of a MAP display:

2 Post the IOC associated with the card and card number by entering:

>IOC ioc_no

and pressing the Enter key.

where

ioc_no is the IOC identification number (0 to 19).

Example of a MAP display:

3 Post the card by entering:

>CARD card_no

and pressing the Enter key.

where

card_no is the card identification number (0 to 8).

IOD
IOC  0  1  2  3
STAT .  .  .  .

IOD
IOC  0  1  2  3
STAT .  .  .  .

DIRP: AMA  B XFER:   .    SLM : SLMbsy NOP :   .    NX25:   .
MLP :   .    DPPP:   .    DPPU:   .    SCAI:   .

IOC   CARD    0     1     2     3     4     5     6     7     8
 0    PORT  0123  0123  0123  0123  0123  0123  0123  0123  0123
      STAT  .---  .---  ....  .---  ....  ----  ..--  .---  ----
      TYPE  MTD   DDU   CONS  MPC   CONS        CONS  MPC
Meridian SL-100 Network Management for SPECTRUM User Guide



24   Software configuration
Example of a MAP display:

4 Manually busy the port on the card by entering:

>ManB port_no

and pressing the Enter key.

where

port_no is the port identification number (0 to 3).

5 Return the port to service by entering:

>RTS port_no

and pressing the Enter key.

where

port_no is the port identification number (0 to 3).

On the Meridian SL-100 MAP terminal window, the port state displays Disc 
until the Sentinel 2000 system connects. When Sentinel 2000 is system 

This procedure is now complete
connected, the port state is . (period).

Datafilling table LOGDEV (permanent logs distribution configuration)
Table LOGDEV lists the log (output message) classes that can be 
printed or displayed at each of the terminal or data devices. Table 
LOGDEV also defines the alternate terminal or data device to which 
messages are sent if the main terminal device is not operational.

Datafilling table LOGDEV establishes a permanent configuration for 
routing logs from the Meridian SL-100 to the Sentinel 2000 system. 
While manually starting log routing is required at the initial system start 
and operation, a permanent configuration allows you to operate the 
system without manually starting the log routing after a system restart.

IOD
IOC  0  1  2  3
STAT .  .  .  .

DIRP: AMA  B XFER:   .    SLM : SLMbsy NOP :   .    NX25:   .
MLP :   .    DPPP:   .    DPPU:   .    SCAI:   .

IOC   CARD    0     1     2     3     4     5     6     7     8
 0    PORT  0123  0123  0123  0123  0123  0123  0123  0123  0123
      STAT  .---  .---  ....  .---  ....  ----  ..--  .---  ----
      TYPE  MTD   DDU   CONS  MPC   CONS        CONS  MPC
Card   6   Ckt      0         1         2         3
Status              .         .         -         -
Cons Id          RD040     RD041     TEAM4     s2kdial
ConType          VT100     VT100     VT100     VT100
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Note: Datafill table TERMDEV, before table LOGDEV.

Table 2
Table LOGDEV

Field Entry Sample data Explanation and action

DEV alphanumeric 
(up to 12 
characters)

s2kdial Device. Enter the name assigned in table TERMDEV 
to the terminal device.

Note: This field can only be set to SCC2 if the office 
parameter SCC2_LOGS in table OFCOPT is Y (yes) and 
field PRIORITY is Y, or if field FORMAT is STD and field 
PRIORITY is N (no).

ALT alphanumeric 
(up to 12 
characters) or 
NIL

NIL Alternate. Enter the name assigned in table 
TERMDEV to the terminal device to which logs are to 
be sent if the main terminal device is not operational. 
If no alternate device is required, enter NIL.

CLASSES vector of 
numeric values 
(0 to 31) with 
delimiter 
characters (, ), 
-, and +

(0-31) Classes. Enter the class numbers that are assigned 
to the terminal device. Enter ( (open bracket) if the 
entry is the first record for the terminal device. If entry 
is a block of consecutive classes, enter the first and 
last class in the block separated by a - (dash). For 
example, if classes are 1, 2, 3, 4, and 5, enter 1-5. 
Separate each log or block of log classes with a blank 
space.

Enter + if additional information for this field is 
contained in the next record. Otherwise, enter ) (close 
bracket) to indicate the end of the tuple. If adding an 
individual entry using the table editor of the switch, a 
single quotation mark must precede the open bracket 
and a single quotation mark must follow the close 
bracket, for example ‘(22 24)’.

FORMAT SCC2 or STD STD Format. Enter SCC2 for the AT&T #2 Switching 
Control Center format. Enter STD for the standard 
format.

Note: This field can only be set to SCC2 if office parameter 
SCC2_LOGS in table OFCOPT is set to Y.

PRIORITY Y or N N Critical message prioritization. Enter Y (yes) if the 
alarm level sets the prioritization of the reports. The 
report with the highest alarm level at any given time 
is generated. Enter N (no) if prioritization is not 
required and the reports are generated in 
chronological order.

Note: This field can only be set to Y if office parameter 
LOG_PRIORITIZATION in table OFCENG is set to Y.

GUAR Y or N N Guaranteed device. Enter Y if the device is 
guaranteed (for example, the device continues to run 
despite the call processing or maintenance load). 
Otherwise, enter N. 

The default value for this field is N.
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Manually starting and stopping logs routing
After setting up the Meridian SL-100 terminal/printer port, (and 
datafilling table LOGDEV for a permanent logs distribution 
configuration), you must start logs routing to the terminal/printer port 
manually. Where table LOGDEV has been datafilled for permanent logs 
distribution configuration, this procedure is required at the initial system 
startup or if a connection between systems has been lost. Where table 
LOGDEV has been datafilled for a temporary or manual logs 
distribution configuration, this procedure is required after each time the 
system is restarted to resume logs distribution to the port.

Procedure 3 describes how to start (and stop, if needed) logs routing to 
the Meridian SL-100 terminal/printer port manually.

Note: The STOPDEV and STARTDEV commands in LOGUTIL can 
be used to turn off and on the flow of logs to the specified port.

After the Sentinel 2000 system communication with the Meridian 
SL-100 is established, use the MAP terminal to start (and stop, if 
needed) routing logs using the log utility.

Procedure 3
Manually start and stop log routing to the Meridian SL-100 
terminal/printer

At the MAP terminal command interpreter prompt (>)
1 Start the log utility by entering:

>LOGUTIL

and pressing the Enter key.

The log utility displays.

In the LOGUTIL utility
2 Start the logs distribution to the IOC terminal/printer port by entering:

>STARTDEV terminal_des.

and pressing the Enter key.

where

terminal_des. is the IOC port dialup designation in the TERMDEV
table.

3 Log routing can be stopped at any time by entering:

>STOPDEV terminal_des.

and pressing the Enter key.

where

terminal_des. is the IOC port dialup designation in the TERMDEV

This procedure is now complete
table.
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Configuring the Sentinel 2000 system
When the Sentinel 2000 system is ordered from MicroFrame Systems, 
Inc. for use with the Meridian SL-100 and SPECTRUM systems, it 
comes configured with customized software, a Meridian SL-100 alarm 
filter, and Nortel Networks trap format. Additional procedures are 
necessary to configure the host port connection, alarm-to-trap mapping 
and network managers. You must know the Sentinel 2000 IP address.

See the MicroFrame User Guide for the Sentinel 2000 for detailed 
information about Sentinel 2000 system software configuration, 
administration, and operations.

Configuring the host port
Verify or setup host port parameters used for the Meridian SL-100 
connection. Use the dh command to display the parameters and the sh 
command to set the parameters. Figure 4 shows an example of the 
Sentinel 2000 system modem port settings.

Figure 4
Example of Sentinel 2000 system modem port settings

Configuring the SNMP manager parameters
After configuring the host port, use the snp command to set the SNMP 
manager parameters. Figure 5 on page 28 shows an example of the 
Sentinel 2000 system manager parameter settings.

>sh1
--- Set Host Port Params ---
Restore Factory Defaults?   no
--Host 1:

Host Name:  MSL100A
Baud Rate Setting   9600
Character Length/Parity   8/None
Alarm Filter   SL100 Alarms

Force CD/DSR High   Yes
Flow Control   XON/XOFF

--Automatic Buffering--
Enable Automatic Buffering?   Yes
Compress closed buffer files?   No
Auto Switch:  (Enter 0 to disable)
   When CURRENT file exceedsn KB   50
   Everyn Hours   24
   - Synchronize at what hour (0-23)   0
Meridian SL-100 Network Management for SPECTRUM User Guide



28   Software configuration
Figure 5
Example of the Sentinel 2000 system SNMP manager parameter settings

Configuring action items for SNMP traps
After setting the SNMP manager parameters, add alarm level action 
items to generate SNMP traps to be sent to the SPECTRUM platform. 
These actions can be configured to send traps for all alarm levels.

Action items must be defined for each alarm level for which SNMP traps 
are generated. Use the aa command to add action items for each alarm 
level. Specify SNMPTRAP with the integer parameter corresponding to 
the alarm level: CRI = 3, MAJ = 2, and MIN = 1. Include meaningful 
comments for action items, because they appear in SpectroGRAPH 
alarm details.

Figure 6 on page 29 shows an example of defined actions for the three 
Meridian SL-100 log report alarm levels.

Note: In this example, an SNMP trap is sent for each alarm level with 
a parameter indicating the alarm level.

>snp
--- Set Network Params ---
1=Network Initialization Params
2=SNMP Manager Params

Select Group ->2
Restore Factory Defaults?   no
-- SNMP Manager Parameters --
PPP link needed for trap?   No
Trap format   Nortel
SNMP Community Name   public
-- IP Addresses for SNMP Managers (NNN.NNN.NNN.NNN) --
Manager 1 xxx.xxx.xxx.xxx (Note: Enter SpectroSERVER IP address)
Manager 2
Manager 3
Manager 4
Manager 5
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Figure 6
Example of the Sentinel 2000 system SNMP manager parameter settings

Obtaining the Sentinel 2000 IP address
After adding alarm level action items to generate SNMP traps, use the 
dnp command to display the Sentinel 2000 IP address and other 
network parameters. Use this IP address in the model IP address field 
when creating the MSL-100 icon in the SpectroGRAPH GUI.

Figure 7 shows an example of the network parameters display.

Figure 7
Example of the Sentinel 2000 system network parameter display

The Sentinel 2000 system is now configured and ready for startup. 
Figure 8 on page 30 depicts the logical logs flow according to the 
system you have configured.

>la

--- List Action Items ---
Alarm Routine: Parameters: Comments:

1) CRI SNMPTRAP3 Critical
2) MAJ SNMPTRAP2 Major
3) MIN SNMPTRAP1 Minor
4) NON NOACT (not an alarm)

-- End of List --

>dnp

--- Display Network Params ---
--- Network Initialization Parameters ---
Start Network On Power-up? Yes
Ethernet Address (hhhhhhhhhhhh): 09 23 02 12 00 EE
IP Address (nnn.nnn.nnn.nnn): 48.77.204.154
PPP Address (nnn.nnn.nnn.nnn): 121.91.203.4
Subnet Mask (nnn.nnn.nnn.nnn): 25.255.240.0
Default Gateway (nnn.nnn.nnn.nnn): 48.77.204.100
Network-Loss Alarm Delay Time: 60
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Figure 8
Logical DMS logs flow

The Meridian SL-100 logs and alarms are directed to the Sentinel 2000 
system where these original logs and alarms are mapped to SNMP 
traps. The SNMP traps from the Sentinel 2000 are routed to the 
SpectroSERVER where the traps have been configured in association 
with action items. These action items produce alarms with event 
information and are displayed in the SpectroGRAPH GUI.

You are ready to begin operating the system. Operating procedures are 
described in the “Getting started” on page 31.
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Getting started
This chapter provides information about getting started using the 
Sentinel 2000 and the SPECTRUM systems. Familiarity with Meridian 
SL-100, the MAP terminal, the Sentinel 2000 system, and SPECTRUM 
systems is required. See the manufacturer’s documentation for 
instructions about operating individual system hardware and software. 
See the Meridian SL-100 Log Report Reference Manual for information 
about Meridian SL-100 alarms. See Getting Started with SPECTRUM 
and the SPECTRUM system on-line help for information about using 
the SPECTRUM system. See the MicroFrame User Guide for the 
Sentinel 2000 for information about using the Sentinel 2000 system.

Once hardware and software configuration is complete, you are ready 
to start the event monitoring and alarm resolution activities. Use the 
following steps when operating the system:

1. Create a new Meridian SL-100 model in SpectroGRAPH.

2. Login to the Sentinel 2000 system.

3. Connect to the Meridian SL-100 from the Sentinel 2000 system.

4. Start Meridian SL-100 log routing to the Sentinel 2000 system.

5. Monitor the MSL-100 icon for alarm notification.

6. Analyze events and alarms when notification is indicated.

7. Resolve alarms using a telnet session from the SPECTRUM system 
to the MAP terminal.

8. Manually clear the alarms in the SPECTRUM system.

SpectroGRAPH presents network device information from several 
perspectives within three hierarchical views: topology, location, and 
organizational.

See the SPECTRUM System User Guide for detailed information about 
setting up the hierarchical views in SpectroGRAPH.
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Using the SPECTRUM system views
Use SpectroGRAPH system views to create Meridian SL-100 models, 
monitor the MSL-100 icon for alarm interpretation, and perform alarm 
clearing procedures.

Creating a new model of the Meridian SL-100 in a SpectroGRAPH system 
view

After starting SpectroSERVER and SpectroGRAPH, use Procedure 4 
to add a new Meridian SL-100 model to a SpectroGRAPH view.

Procedure 4
Create a new model of the Meridian SL-100 in a SPECTRUM 
system view

At the SpectroGRAPH view window:

1 Click the File menu item and select Edit.

A grid appears in the view background.

2 Click the Edit menu item and select New Model.

The Select Model Type window showing a list of model types displays.

3 Select MSL-100 from the model type list and click OK.

The Creating MSL-100 window displays.

4 Fill in the fields in the Creating MSL-100 window as shown in Table 3.

Table 3
Creating MSL-100 fields

Field Description

Model name: Enter a model name of your choice. The icon representing the 
switch will have the name that you enter in this field.

Network 
address:

Enter the Sentinel 2000 system IP address.

RMAP 
Address:

Enter the Meridian SL-100 ethernet interface unit (EIU) address. 
If no EIU is present, enter an IP address of a network node to 
which you may want to connect from the SPECTRUM system.

Community 
name:

Leave supplied entry unchanged.

Location: Optional. Enter information for your own purposes.

Contact: Optional. Enter information for your own purposes.

Serial number: Optional. Enter information for your own purposes.

Security 
string:

Unused. Leave as is.
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5 Click OK.

An icon representing the new model appears in the SpectroGRAPH universe 
view.

6 Click the File menu and select Save & Close.

This procedure is now complete
The grid disappears and the model type icon indicates the system status.

If the SPECTRUM system has made contact with the device since the 
model was created, the contact status label device condition color is 
initially green. If no contact has been made, the contact status label 
device condition color is blue. Figure 9 illustrates a contact status label 
example as it appears in the SPECTRUM system GUI.

Figure 9
Contact status label display example

Connecting to the Meridian SL-100 from the Sentinel 2000 system
The next step after creating an Meridian SL-100 switch model in 
SpectroGRAPH is to establish a host connection from the Sentinel 
2000 system to the switch. Use Procedure 5 on page 34 to connect to 
the Meridian SL-100 from Sentinel 2000 system.

Polling 
interval:

Supplied. Denotes the frequency of the polling interval.

Log ration: Supplied.

Device type: Defaults to switch. Leave supplied entry unchanged.

Table 3
Creating MSL-100 fields (Continued)

Field Description

Meridan SL-100

Model Type

MAP
Device condition color
indicator

Rollup condition color
indicator

Device condition colors
Green - No alarms
Blue - No contact with device
Yellow - Minor alarm
Orange - Major or critical alarm
Red - Device contact lost
(connection to Sentinel 200 has
been lost; inability to receive
traps)
Grey - Device not reached due
to error condition of another
device

Rollup condition colors
Yellow - Information Alarm
Orange - Minor failure
 Red - Major failure

G100276
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Procedure 5
Connect to the Meridian SL-100 from the Sentinel 2000 system

At the Sentinel 2000 system login window:
1 Login to the Sentinel 2000 system (either by direct terminal connection or by 

telnet).

2 Initiate dial out to the host port connected to the Meridian SL-100 IOC port by 
entering:

>js port_no

and pressing Enter.

where

port_no is the port identification number (1 to 4).
Note: At this point, you can send AT commands to the Meridian SL-100 modem.

3 Test the modem response by entering:

>AT

and pressing the Enter key.

OK displays.

4 At the prompt, enter the appropriate modem commands to dial the Meridian 
SL-100 IOC port.

On the Meridian SL-100 MAP terminal window, the port state displays Disc 
until the Sentinel 2000 system connects. When the Sentinel 2000 system is 
connected, the port state is . (period).

On the Sentinel 2000 system host session display, Connect 9600 is displayed 

This procedure is now complete
indicating the connection is established.

Starting Meridian SL-100 log routing to the Sentinel 2000 system
The purpose of Procedure 3 on page 26 is to direct logs to the Sentinel 
2000 system. If you configured your system by datafilling table 
LOGDEV (the permanent configuration), and you have not stopped the 
log routing process, you can see generated logs on the Sentinel 2000 
in the host session. If you can see generated logs, skip Procedure 3 on 
page 26 and go on to “Monitoring the MSL-100 icon for alarm 
indications” on page 35.

After the Sentinel 2000 system communication with the Meridian 
SL-100 is established, use the MAP terminal to start (and stop, if 
needed) routing logs using the log utility.
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Monitoring the MSL-100 icon for alarm indications
You are ready to monitor the MSL-100 icon displayed in the 
SpectroGRAPH view for alarms and events. See Figure 9 on page 33 
for basic information about icon indicators.

Use Procedure 6 to monitor events and alarm notifications for an 
Meridian SL-100 model in SpectroGRAPH.

Note: If the icon is any color other than green, or if the icon is 
blinking, diagnose and resolve any alarms, faults, or errors in 
modeling. Refer to the SPECTRUM system on-line help for detailed 
rollup condition and device condition color interpretation.

Procedure 6
Monitoring events and alarms in SpectroGRAPH

At the SPECTRUM view window:
1 Use the right mouse button to click the icon representing the Meridian SL-100 

switch to access the Alarms view.

The Alarms manager window displays showing information about the 
alarms. Use this information to determine the actions needed to resolve the 
alarm in the Meridian SL-100 MAP terminal.

2 Examine the events information tab for a selected alarm in the alarm 
manager.

Note: The tab labelled “Events” contains detailed alarm information including the 
original Meridian SL-100 log report text.

3 Close the Alarms manager by clicking the window close bar or clicking the 

This procedure is now complete
File menu item and selecting Exit.

Actual Meridian SL-100 maintenance functions must be accomplished 
using a MAP terminal. After you have analyzed the alarm using the 
SPECTRUM system, use the next procedure to resolve the alarm by 
accessing MAP terminal using a telnet session from the SPECTRUM 
system.

Resolving alarms using a telnet session from the SPECTRUM system to 
the MAP terminal

Use Procedure 7 on page 36 to establish a telnet (or communication) 
session from the SPECTRUM system to the Meridian SL-100 MAP 
terminal.
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Procedure 7
Resolve alarms using a telnet session from the SPECTRUM 
system to the MAP terminal

At a SpectroGRAPH view:
1 Double click the center of the MSL-100 icon or use the right mouse pull-down 

menu to select the MSL100 CsSTel Script menu item.

A telnet window displays the MAP terminal login.
Note 1: If you entered the Meridian SL-100 EIU address in the Model Creation 
window RMAP Address field, the MAP terminal login displays.

Note 2: If you entered some other IP address in the RMAP Address field, the telnet 
window is populated with the appropriate system connection or login information.

2 Diagnose and resolve all Meridian SL-100 alarms reported in the 
SPECTRUM alarm events information using standard maintenance 
procedures for the Meridian SL-100.

This procedure is now complete
3 Logout of the MAP terminal and disconnect the telnet session.

Manually clearing alarms in the SpectroGRAPH alarms manager
Use Procedure 8 to clear alarms after resolving alarms using the MAP 
terminal.

Note: Clearing several alarms at the same time requires a relatively 
long time period. For this reason, avoid clearing many alarms at 
once.

Procedure 8
Manually clear alarms in the SpectroGRAPH alarm manager

At the SpectroGRAPH view:

1 Use the right mouse button to click the center of the MSL-100 icon.

The Alarm Manager window displays.

2 Select the alarm(s) to be cleared.

3 Click the Actions menu item and select Clear or Clear All.

This procedure is now complete

ATTENTION
If alarms are not received, verify:

• Sentinel 2000 system is connected to the host port

• Sentinel 2000 system is configured to send traps

• Logs are being routed to the Sentinel 2000 system

Attention
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List of terms
CI

Command interpreter. A component in the support operating system 
(SOS) that functions as the main interface between machine and 
user. 

CM
Computing module. The process and memory of a dual-plane 
combined core (DPCC) used by DMS SuperNode.

EIU
Ethernet Interface Unit. The EIU is used to provide access to the 
MAP terminal from third party computing equipment (workstations, 
terminals, and printers) connected to the Meridian SL-100 by way of 
an external Ethernet LAN.

ETAS
Emergency technical assistance service.

GUI
Graphical user interface.

IOC
Input/output controller. A level in the maintenance and administration 
position (MAP) terminal. An equipment shelf that provides an 
interface between up to 36 input/output (I/O) devices and the central 
message controller (CMC). 

LAN
Local area network. A network that permits the interconnection and 
intercommunication between multiple computers.

LIU7
Common channel signaling 7 (CCS7) link interface unit (LIU7). A 
peripheral module that processes messages entering and leaving a 
link peripheral processor through an individual signaling data link. 
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LPP
Link peripheral processor. The DMS SuperNode equipment frame or 
cabinet that contains two types of peripheral modules: a link interface 
module (LIM) and one or more application-specific units (ASUs).

MAP
Maintenance and administration position. A group of components 
that provides a user interface between operating company personnel 
and DMS-100 Family switches. The interface consists of a video 
display unit (VDU) and keyboard, a voice communications module, 
test facilities, and special hardware.

MIBS
Management information base structure. Structure used to define 
data management by Simple Network Management Protocol 
(SNMP). MIBS tools consist of a collection of applications that allow 
access and the management of any SNMP-compliant device through 
its MIBS. 

MS
Message switch. A high-capacity communications facility that 
functions as the messaging hub of the dual-plane combined core 
(DPCC) of a DMS SuperNode processor.

NIU
Network interface unit. A peripheral module that provides the 
interface between an LIU7 in an LPP or enhanced multipurpose 
cabinet and the DMS-bus.

OM
Operational measurement. The hardware and software resources of 
the DMS-100 family switches that control the collection and display 
of measurements taken on an operating system. The OM subsystem 
organizes the measurement data and manages its transfers to 
displays and records. The OM data is used for maintenance, traffic, 
accounting, and provisioning decisions.

SNMP
Simple Network Management Protocol. A standard network 
management protocol developed by the Internet Engineering Task 
Force (IETF).

TCP/IP
Transmission control protocol/internet protocol. A collection of 
network protocols referred to as Internet Protocol Suite. A protocol 
that allows multi-vendor computer networks to share and 
communicate data across a network.

TTP
Trunk test positions. A maintenance and administration position 
(MAP) terminal specially equipped to perform trunk testing.
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	• Switch system management is integrated with other systems in one environment.




	Hardware components
	Hardware components
	The Sentinel 2000 system and the SPECTRUM network management system for Meridian SL-100 consists ...
	The Sentinel 2000 system and the SPECTRUM network management system for Meridian SL-100 consists ...
	• Meridian SL-100 switch
	• Meridian SL-100 switch
	• Meridian SL-100 switch

	• Sentinel 2000 system (by MicroFrame, Inc.)
	• Sentinel 2000 system (by MicroFrame, Inc.)

	• One or two Windows NT computers running Cabletron Systems, Inc.’s SPECTRUM software:
	• One or two Windows NT computers running Cabletron Systems, Inc.’s SPECTRUM software:
	— SpectroSERVER
	— SpectroSERVER
	— SpectroSERVER

	— SpectroGRAPH
	— SpectroGRAPH





	The Sentinel 2000 system configuration is factory-customized to accommodate an interface between ...
	The Sentinel 2000 system configuration is factory-customized to accommodate an interface between ...


	Meridian SL-100 switch module
	Meridian SL-100 switch module
	Meridian SL-100 logs are sent to the Sentinel 2000 system over a 9600 baud modem dial-up, or dire...
	Meridian SL-100 logs are sent to the Sentinel 2000 system over a 9600 baud modem dial-up, or dire...

	For more information about the EIU and LPP, refer to the Meridian SL-100 Ethernet Interface Unit ...
	For more information about the EIU and LPP, refer to the Meridian SL-100 Ethernet Interface Unit ...


	Sentinel 2000 system module
	Sentinel 2000 system module
	The Sentinel 2000 system is operated and administered using a command line interface on a dumb te...
	The Sentinel 2000 system is operated and administered using a command line interface on a dumb te...

	The Sentinel 2000 system post processor receives logs, performs the log analysis, and generates t...
	The Sentinel 2000 system post processor receives logs, performs the log analysis, and generates t...
	Figure�1�� The network management system logical data flow
	Figure�1�� The network management system logical data flow
	<GRAPHIC>


	The system operator can use the Sentinel 2000 system to monitor logs processing and other system ...
	The system operator can use the Sentinel 2000 system to monitor logs processing and other system ...

	For detailed information on the Sentinel 2000 system operation, see the User Guide for the Sentin...
	For detailed information on the Sentinel 2000 system operation, see the User Guide for the Sentin...


	SPECTRUM system module
	SPECTRUM system module
	SPECTRUM system is based on client/server architecture. The client, called SpectroGRAPH, provides...
	SPECTRUM system is based on client/server architecture. The client, called SpectroGRAPH, provides...

	Configuration and management of the Meridian SL-100 is accomplished in two ways:
	Configuration and management of the Meridian SL-100 is accomplished in two ways:
	• by launching a telnet session from the MSL100 icon on the SPECTRUM system GUI to the Meridian S...
	• by launching a telnet session from the MSL100 icon on the SPECTRUM system GUI to the Meridian S...
	• by launching a telnet session from the MSL100 icon on the SPECTRUM system GUI to the Meridian S...

	• by launching a telnet session from the MSL100 icon on the SPECTRUM system GUI to a terminal ser...
	• by launching a telnet session from the MSL100 icon on the SPECTRUM system GUI to a terminal ser...



	For detailed information about the SPECTRUM system, see Getting Started with SPECTRUM and other C...
	For detailed information about the SPECTRUM system, see Getting Started with SPECTRUM and other C...



	General steps for system setup and operation
	General steps for system setup and operation
	First, setup the hardware according to
	First, setup the hardware according to

	Second, configure ports, install any software required, and begin initial logs distribution using
	Second, configure ports, install any software required, and begin initial logs distribution using

	Finally, operate the systems to aid in Meridian SL-100 network management using
	Finally, operate the systems to aid in Meridian SL-100 network management using



	Physical connections
	Physical connections
	This chapter describes system requirements and physical hardware connections of the Sentinel 2000...
	This chapter describes system requirements and physical hardware connections of the Sentinel 2000...
	Figure�2�� Sentinel 2000 cable connections (modem direct connection)
	Figure�2�� Sentinel 2000 cable connections (modem direct connection)
	<GRAPHIC>


	See the SPECTRUM Installation Guide, the MicroFrame Installation Guide, the MicroFrame User Guide...
	See the SPECTRUM Installation Guide, the MicroFrame Installation Guide, the MicroFrame User Guide...

	Meridian SL-100 system requirements
	Meridian SL-100 system requirements
	The Meridian SL-100 requires:
	The Meridian SL-100 requires:
	• MSL05 (or above) software
	• MSL05 (or above) software
	• MSL05 (or above) software

	• Input/output controller (IOC) terminal/printer port with an optional 9600 baud modem
	• Input/output controller (IOC) terminal/printer port with an optional 9600 baud modem

	• EIU resident on the LPP (for telnet option); or Single shelf link peripheral processor (SSLPP) ...
	• EIU resident on the LPP (for telnet option); or Single shelf link peripheral processor (SSLPP) ...




	Sentinel 2000 system requirements
	Sentinel 2000 system requirements
	In the Sentinel 2000 and the SPECTRUM systems configuration, the Sentinel 2000 system requires:
	In the Sentinel 2000 and the SPECTRUM systems configuration, the Sentinel 2000 system requires:
	• factory-installed Meridian SL-100 post-processing routine (log parser) with Meridian SL-100 ala...
	• factory-installed Meridian SL-100 post-processing routine (log parser) with Meridian SL-100 ala...
	• factory-installed Meridian SL-100 post-processing routine (log parser) with Meridian SL-100 ala...

	• SNMP proxy agent with Nortel Networks trap format support
	• SNMP proxy agent with Nortel Networks trap format support

	• 9600 bps baud modem to analog line (for dial-up to the Meridian SL-100 terminal/printer port)
	• 9600 bps baud modem to analog line (for dial-up to the Meridian SL-100 terminal/printer port)

	• RS-232C cable (for modem connection)
	• RS-232C cable (for modem connection)

	• telephone cords with RJ11 connector
	• telephone cords with RJ11 connector

	• network cable with an AUI or 10 Base-T connector (furnished with ethernet card in Sentinel 2000...
	• network cable with an AUI or 10 Base-T connector (furnished with ethernet card in Sentinel 2000...

	• assigned ethernet address for network applications (furnished with ethernet card in Sentinel 20...
	• assigned ethernet address for network applications (furnished with ethernet card in Sentinel 20...

	• assigned IP address (for network applications)
	• assigned IP address (for network applications)

	• local terminal, or PC running a terminal emulation program, (used to initialize and administer ...
	• local terminal, or PC running a terminal emulation program, (used to initialize and administer ...
	— asynchronous
	— asynchronous
	— asynchronous

	— 9600 bps
	— 9600 bps

	— 8-bit character length, one stop bit, no parity
	— 8-bit character length, one stop bit, no parity

	— XON/OFF (software) flow control
	— XON/OFF (software) flow control






	SPECTRUM system requirements
	SPECTRUM system requirements
	Cabletron Systems, Inc. offers several system configurations for the SPECTRUM system. The Spectro...
	Cabletron Systems, Inc. offers several system configurations for the SPECTRUM system. The Spectro...
	• LAN connection – Enterprise LAN connection for each platform running either SpectroSERVER or Sp...
	• LAN connection – Enterprise LAN connection for each platform running either SpectroSERVER or Sp...
	• LAN connection – Enterprise LAN connection for each platform running either SpectroSERVER or Sp...

	• SCSI drive – Cabletron Systems, Inc. recommends running the SPECTRUM system only on platforms w...
	• SCSI drive – Cabletron Systems, Inc. recommends running the SPECTRUM system only on platforms w...

	• 96 MB of RAM for SpectroSERVER workstations or 64 MB for SpectroGRAPH GUI workstations (minimum...
	• 96 MB of RAM for SpectroSERVER workstations or 64 MB for SpectroGRAPH GUI workstations (minimum...

	• 1 GB of disk space for SpectroSERVER workstations or 500 MB for SpectroGRAPH GUI workstations (...
	• 1 GB of disk space for SpectroSERVER workstations or 500 MB for SpectroGRAPH GUI workstations (...

	• CD-ROM drive (for loading the SPECTRUM system).
	• CD-ROM drive (for loading the SPECTRUM system).

	• 1024 x 768 PCI bus video card supporting 256 colors or 8-bit color with at least 2 MB of DRAM.
	• 1024 x 768 PCI bus video card supporting 256 colors or 8-bit color with at least 2 MB of DRAM.

	• 17-inch color monitor for workstations running SpectroGRAPH software.
	• 17-inch color monitor for workstations running SpectroGRAPH software.




	Physical hardware connections
	Physical hardware connections
	Physical cable connections depend upon the type of system configuration selected. The configurati...
	Physical cable connections depend upon the type of system configuration selected. The configurati...
	Note:�� Since it is not practical to describe all possible configurations or all possible connect...
	Note:�� Since it is not practical to describe all possible configurations or all possible connect...


	Figure 2 on page 15
	Figure 2 on page 15
	Figure 2 on page 15


	Meridian SL-100 cable connections
	Meridian SL-100 cable connections
	Cable connections from the Meridian SL-100 are as follows:
	Cable connections from the Meridian SL-100 are as follows:
	• Connect the Meridian SL-100 IOC terminal/printer port to a host port on the Sentinel 2000 syste...
	• Connect the Meridian SL-100 IOC terminal/printer port to a host port on the Sentinel 2000 syste...
	• Connect the Meridian SL-100 IOC terminal/printer port to a host port on the Sentinel 2000 syste...

	• Connect the EIU LPP or the SSLPP to the enterprise LAN where the Sentinel 2000 and the SPECTRUM...
	• Connect the EIU LPP or the SSLPP to the enterprise LAN where the Sentinel 2000 and the SPECTRUM...



	See the Meridian SL-100 Product Guide, for detailed information about Meridian SL-100 cabling req...
	See the Meridian SL-100 Product Guide, for detailed information about Meridian SL-100 cabling req...


	Sentinel 2000 system cable connections
	Sentinel 2000 system cable connections
	Cable connections from the Sentinel 2000 system are as follows:
	Cable connections from the Sentinel 2000 system are as follows:
	• Connect the PC or terminal to the Aux port – This connection is used to initialize the Sentinel...
	• Connect the PC or terminal to the Aux port – This connection is used to initialize the Sentinel...
	• Connect the PC or terminal to the Aux port – This connection is used to initialize the Sentinel...

	• Connect the Meridian SL-100 IOC terminal/printer port to a host port on the Sentinel 2000 syste...
	• Connect the Meridian SL-100 IOC terminal/printer port to a host port on the Sentinel 2000 syste...

	• Connect the Sentinel 2000 system internal modem(s) to analog telephone line(s) for remote Senti...
	• Connect the Sentinel 2000 system internal modem(s) to analog telephone line(s) for remote Senti...

	• Connect the Sentinel 2000 system to the enterprise LAN either through the AIU or 10 Base-T conn...
	• Connect the Sentinel 2000 system to the enterprise LAN either through the AIU or 10 Base-T conn...



	See the MicroFrame Installation Guide for Sentinel 2000 for detailed information about the Sentin...
	See the MicroFrame Installation Guide for Sentinel 2000 for detailed information about the Sentin...


	SPECTRUM system cable connections
	SPECTRUM system cable connections
	The SPECTRUM systems (SpectroGRAPH and SpectroSERVER) are connected to the Ethernet LAN. See the ...
	The SPECTRUM systems (SpectroGRAPH and SpectroSERVER) are connected to the Ethernet LAN. See the ...




	Software configuration
	Software configuration
	This chapter explains the software installation and configuration for the Sentinel 2000 and the S...
	This chapter explains the software installation and configuration for the Sentinel 2000 and the S...

	See the SPECTRUM Installation Guide, the MicroFrame User Guide, the MicroFrame Installation Guide...
	See the SPECTRUM Installation Guide, the MicroFrame User Guide, the MicroFrame Installation Guide...

	The Sentinel 2000 and the SPECTRUM systems software configuration for the Meridian SL-100 includes:
	The Sentinel 2000 and the SPECTRUM systems software configuration for the Meridian SL-100 includes:
	• installing the Meridian SL-100 management module on the SPECTRUM server system (SpectroSERVER)
	• installing the Meridian SL-100 management module on the SPECTRUM server system (SpectroSERVER)
	• installing the Meridian SL-100 management module on the SPECTRUM server system (SpectroSERVER)

	• installing the Meridian SL-100 model type on the SPECTRUM client system (SpectroGRAPH)
	• installing the Meridian SL-100 model type on the SPECTRUM client system (SpectroGRAPH)

	• configuring the Meridian SL-100 terminal/printer port (datafilling table TERMDEV)
	• configuring the Meridian SL-100 terminal/printer port (datafilling table TERMDEV)

	• configuring the Meridian SL-100 permanent log distribution (datafilling table LOGDEV) (optional)
	• configuring the Meridian SL-100 permanent log distribution (datafilling table LOGDEV) (optional)

	• configuring software on the Sentinel 2000 system
	• configuring software on the Sentinel 2000 system



	Installing the Meridian SL-100 management module on the SpectroSERVER system
	Installing the Meridian SL-100 management module on the SpectroSERVER system
	The Meridian SL-100 management module must be installed on the SPECTRUM SpectroSERVER and Spectro...
	The Meridian SL-100 management module must be installed on the SPECTRUM SpectroSERVER and Spectro...

	The Meridian SL-100 model type (defined by the Meridian SL-100 management module) includes defini...
	The Meridian SL-100 model type (defined by the Meridian SL-100 management module) includes defini...

	These Meridian SL-100 models are represented by icons in the SpectroGRAPH GUI. Operators monitor ...
	These Meridian SL-100 models are represented by icons in the SpectroGRAPH GUI. Operators monitor ...

	Use
	Use
	Note:�� This procedure assumes SpectroSERVER and SpectroGRAPH have been installed and are functio...
	Note:�� This procedure assumes SpectroSERVER and SpectroGRAPH have been installed and are functio...


	Procedure�1�� Install the Meridian SL-100 management module on the SPECTRUM system
	Procedure�1�� Install the Meridian SL-100 management module on the SPECTRUM system
	1 Place the MSL-100 MM CD in the CD ROM drive.
	1 Place the MSL-100 MM CD in the CD ROM drive.

	2 Start SPECTRUM from the Start/Programs menu.
	2 Start SPECTRUM from the Start/Programs menu.
	This starts the SpectroSHELL software.

	3 At the SpectroSHELL prompt, Start the installation program by entering:
	3 At the SpectroSHELL prompt, Start the installation program by entering:
	drive:/MMinstall
	where
	drive is the CD ROM drive on the computer.
	Example: d:/MMinstall

	4 At the extraction key confirmation request prompt, click OK.
	4 At the extraction key confirmation request prompt, click OK.
	Note:�� If the installation program prompts a request for the extraction key, enter the SPECTRUM ...
	Note:�� If the installation program prompts a request for the extraction key, enter the SPECTRUM ...


	5 When the SPECTRUM Host Evaluation window displays, verify the physical memory and swap space re...
	5 When the SPECTRUM Host Evaluation window displays, verify the physical memory and swap space re...

	6 When the Installation Configuration window and the Component Configuration subwindow displays, ...
	6 When the Installation Configuration window and the Component Configuration subwindow displays, ...

	7 Click the Select all SpectroGRAPH components check box to install the SpectroGRAPH management m...
	7 Click the Select all SpectroGRAPH components check box to install the SpectroGRAPH management m...

	8 At the Installation successful prompt, click OK.
	8 At the Installation successful prompt, click OK.

	9 Click Exit to exit the installation.
	9 Click Exit to exit the installation.




	Meridian SL-100 configuration
	Meridian SL-100 configuration
	This section describes the logs distribution to the Sentinel 2000 and the Meridian SL-100 datafil...
	This section describes the logs distribution to the Sentinel 2000 and the Meridian SL-100 datafil...

	This procedure requires access to the Meridian SL-100 maintenance and administration position MAP...
	This procedure requires access to the Meridian SL-100 maintenance and administration position MAP...

	Datafilling table TERMDEV
	Datafilling table TERMDEV
	Use the TERMDEV table to setup the input/output controller (IOC) port for the Sentinel 2000 syste...
	Use the TERMDEV table to setup the input/output controller (IOC) port for the Sentinel 2000 syste...
	<TABLE>
	Table�1�� Table TERMDEV�
	<TABLE HEADING>
	<TABLE ROW>
	Field
	Entry
	Sample data
	Explanation and action


	<TABLE BODY>
	<TABLE ROW>
	TERMDES
	1 to 8 alphanumeric characters
	S2k
	Terminal designation. Enter the name for each terminal device.

	<TABLE ROW>
	IOCNO
	0 to 19
	2
	Input/output controller number. Enter the number of the IOC to which the terminal device is assig...

	<TABLE ROW>
	CKTNO
	0 to 35
	15
	Input/output controller circuit number. Enter the IOC circuit number to which the terminal device...

	<TABLE ROW>
	TERMTYPE
	alphanumeric
	VT100
	Terminal type. Enter the terminal type. Valid entries are HAZ, LSG, VUC4, KSR, PRT, HP, VT100, VT...

	<TABLE ROW>
	BAUDRT
	alphanumeric
	B9600
	Baud rate. Enter the baud rate of the terminal device. Valid entries are: B110, B134PT5, B150, B3...

	<TABLE ROW>
	INTYP
	alpha
	EIA
	Interface type. If the terminal device is equipped with a data set or modem, enter EIA (Electroni...

	<TABLE ROW>
	EQPEC
	alphanumeric
	1X89BB
	Equipment product engineering code (PEC). Enter the PEC of the terminal controller circuit card. ...

	<TABLE ROW>
	PRTY
	See subfield.
	NONE
	Parity. Enter the parity of the terminal device. Valid entries are ODD, EVEN, and NONE.

	<TABLE ROW>
	GUAR
	Y or N
	N
	Guaranteed device. Enter Y if the device is guaranteed to run despite the call processing or main...

	<TABLE ROW>
	MODEM
	NONE, DBANS, CTS, RIXON, and UDS
	NONE
	Modem type. Enter the type of modem that corresponds to its connecting port. Valid entries are NO...

	<TABLE ROW>
	COMCLASS
	ALL
	Command class. Enter the command class allowed for the terminal device. Valid entries are from 0 ...

	<TABLE ROW>
	CKERDISC
	Y or N
	Y
	CkEr alarm on DISconnected device. Enter Y if the device will cause a CkEr alarm whenever it is i...




	Figure 3
	Figure 3
	Figure 3

	Figure�3�� MAP display example for table TERMDEV
	Figure�3�� MAP display example for table TERMDEV
	<GRAPHIC>



	Meridian SL-100 terminal/printer port maintenance
	Meridian SL-100 terminal/printer port maintenance
	Procedure 2 on page 23
	Procedure 2 on page 23
	Procedure 2 on page 23


	Procedure�2�� Maintain the terminal/printer port using MAP
	Procedure�2�� Maintain the terminal/printer port using MAP
	At the MAP terminal command interpreter prompt
	At the MAP terminal command interpreter prompt
	1 Access the IOD level of the MAP display by entering:
	1 Access the IOD level of the MAP display by entering:
	>MAPCI;MTC;IOD
	and pressing the Enter key.
	Example of a MAP display:

	2 Post the IOC associated with the card and card number by entering:
	2 Post the IOC associated with the card and card number by entering:
	>IOC ioc_no
	and pressing the Enter key.
	where
	ioc_no is the IOC identification number (0 to 19).
	Example of a MAP display:

	3 Post the card by entering:
	3 Post the card by entering:
	>CARD card_no
	and pressing the Enter key.
	where
	card_no is the card identification number (0 to 8).
	Example of a MAP display:

	4 Manually busy the port on the card by entering:
	4 Manually busy the port on the card by entering:
	>ManB port_no
	and pressing the Enter key.
	where
	port_no is the port identification number (0 to 3).

	5 Return the port to service by entering:
	5 Return the port to service by entering:
	>RTS port_no
	and pressing the Enter key.
	where
	port_no is the port identification number (0 to 3).
	On the Meridian SL-100 MAP terminal window, the port state displays Disc until the Sentinel 2000 ...




	Datafilling table LOGDEV (permanent logs distribution configuration)
	Datafilling table LOGDEV (permanent logs distribution configuration)
	Table LOGDEV lists the log (output message) classes that can be printed or displayed at each of t...
	Table LOGDEV lists the log (output message) classes that can be printed or displayed at each of t...

	Datafilling table LOGDEV establishes a permanent configuration for routing logs from the Meridian...
	Datafilling table LOGDEV establishes a permanent configuration for routing logs from the Meridian...
	Note:�� Datafill table TERMDEV, before table LOGDEV.
	Note:�� Datafill table TERMDEV, before table LOGDEV.

	<TABLE>
	Table�2�� Table LOGDEV�
	<TABLE HEADING>
	<TABLE ROW>
	Field
	Entry
	Sample data
	Explanation and action


	<TABLE BODY>
	<TABLE ROW>
	DEV
	alphanumeric (up to 12 characters)
	s2kdial
	Device. Enter the name assigned in table TERMDEV to the terminal device.

	<TABLE ROW>
	ALT
	alphanumeric (up to 12 characters) or NIL
	NIL
	Alternate. Enter the name assigned in table TERMDEV to the terminal device to which logs are to b...

	<TABLE ROW>
	CLASSES
	vector of numeric values (0 to 31) with delimiter characters (, ), -, and +
	(0-31)
	Classes. Enter the class numbers that are assigned to the terminal device. Enter ( (open bracket)...

	<TABLE ROW>
	FORMAT
	SCC2 or STD
	STD
	Format. Enter SCC2 for the AT&T #2 Switching Control Center format. Enter STD for the standard fo...

	<TABLE ROW>
	PRIORITY
	Y or N
	N
	Critical message prioritization. Enter Y (yes) if the alarm level sets the prioritization of the ...

	<TABLE ROW>
	GUAR
	Y or N
	N
	Guaranteed device. Enter Y if the device is guaranteed (for example, the device continues to run ...





	Manually starting and stopping logs routing
	Manually starting and stopping logs routing
	After setting up the Meridian SL-100 terminal/printer port, (and datafilling table LOGDEV for a p...
	After setting up the Meridian SL-100 terminal/printer port, (and datafilling table LOGDEV for a p...

	Procedure 3
	Procedure 3
	Procedure 3

	Note:�� The STOPDEV and STARTDEV commands in LOGUTIL can be used to turn off and on the flow of l...
	Note:�� The STOPDEV and STARTDEV commands in LOGUTIL can be used to turn off and on the flow of l...


	After the Sentinel 2000 system communication with the Meridian SL-100 is established, use the MAP...
	After the Sentinel 2000 system communication with the Meridian SL-100 is established, use the MAP...

	Procedure�3�� Manually start and stop log routing to the Meridian SL-100 terminal/printer
	Procedure�3�� Manually start and stop log routing to the Meridian SL-100 terminal/printer
	At the MAP terminal command interpreter prompt (>)
	At the MAP terminal command interpreter prompt (>)
	1 Start the log utility by entering:
	1 Start the log utility by entering:
	>LOGUTIL
	and pressing the Enter key.
	The log utility displays.


	In the LOGUTIL utility
	In the LOGUTIL utility
	2 Start the logs distribution to the IOC terminal/printer port by entering:
	2 Start the logs distribution to the IOC terminal/printer port by entering:
	>STARTDEV terminal_des.
	and pressing the Enter key.
	where
	terminal_des. is the IOC port dialup designation in the TERMDEV table.

	3 Log routing can be stopped at any time by entering:
	3 Log routing can be stopped at any time by entering:
	>STOPDEV terminal_des.
	and pressing the Enter key.
	where
	terminal_des. is the IOC port dialup designation in the TERMDEV table.





	Configuring the Sentinel 2000 system
	Configuring the Sentinel 2000 system
	When the Sentinel 2000 system is ordered from MicroFrame Systems, Inc. for use with the Meridian ...
	When the Sentinel 2000 system is ordered from MicroFrame Systems, Inc. for use with the Meridian ...

	See the MicroFrame User Guide for the Sentinel 2000 for detailed information about Sentinel 2000 ...
	See the MicroFrame User Guide for the Sentinel 2000 for detailed information about Sentinel 2000 ...

	Configuring the host port
	Configuring the host port
	Verify or setup host port parameters used for the Meridian SL-100 connection. Use the dh command ...
	Verify or setup host port parameters used for the Meridian SL-100 connection. Use the dh command ...
	Figure�4�� Example of Sentinel 2000 system modem port settings
	Figure�4�� Example of Sentinel 2000 system modem port settings
	<GRAPHIC>



	Configuring the SNMP manager parameters
	Configuring the SNMP manager parameters
	After configuring the host port, use the snp command to set the SNMP manager parameters.
	After configuring the host port, use the snp command to set the SNMP manager parameters.
	Figure�5�� Example of the Sentinel 2000 system SNMP manager parameter settings
	Figure�5�� Example of the Sentinel 2000 system SNMP manager parameter settings
	<GRAPHIC>



	Configuring action items for SNMP traps
	Configuring action items for SNMP traps
	After setting the SNMP manager parameters, add alarm level action items to generate SNMP traps to...
	After setting the SNMP manager parameters, add alarm level action items to generate SNMP traps to...

	Action items must be defined for each alarm level for which SNMP traps are generated. Use the aa ...
	Action items must be defined for each alarm level for which SNMP traps are generated. Use the aa ...

	Figure 6 on page 29
	Figure 6 on page 29
	Figure 6 on page 29

	Note:�� In this example, an SNMP trap is sent for each alarm level with a parameter indicating th...
	Note:�� In this example, an SNMP trap is sent for each alarm level with a parameter indicating th...

	Figure�6�� Example of the Sentinel 2000 system SNMP manager parameter settings
	Figure�6�� Example of the Sentinel 2000 system SNMP manager parameter settings
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	Obtaining the Sentinel 2000 IP address
	Obtaining the Sentinel 2000 IP address
	After adding alarm level action items to generate SNMP traps, use the dnp command to display the ...
	After adding alarm level action items to generate SNMP traps, use the dnp command to display the ...

	Figure 7
	Figure 7
	Figure 7

	Figure�7�� Example of the Sentinel 2000 system network parameter display
	Figure�7�� Example of the Sentinel 2000 system network parameter display
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	The Sentinel 2000 system is now configured and ready for startup.
	The Sentinel 2000 system is now configured and ready for startup.
	Figure�8�� Logical DMS logs flow
	Figure�8�� Logical DMS logs flow
	<GRAPHIC>


	The Meridian SL-100 logs and alarms are directed to the Sentinel 2000 system where these original...
	The Meridian SL-100 logs and alarms are directed to the Sentinel 2000 system where these original...

	You are ready to begin operating the system. Operating procedures are described in the
	You are ready to begin operating the system. Operating procedures are described in the




	Getting started
	Getting started
	This chapter provides information about getting started using the Sentinel 2000 and the SPECTRUM ...
	This chapter provides information about getting started using the Sentinel 2000 and the SPECTRUM ...

	Once hardware and software configuration is complete, you are ready to start the event monitoring...
	Once hardware and software configuration is complete, you are ready to start the event monitoring...
	1. Create a new Meridian SL-100 model in SpectroGRAPH.
	1. Create a new Meridian SL-100 model in SpectroGRAPH.
	1. Create a new Meridian SL-100 model in SpectroGRAPH.

	2. Login to the Sentinel 2000 system.
	2. Login to the Sentinel 2000 system.

	3. Connect to the Meridian SL-100 from the Sentinel 2000 system.
	3. Connect to the Meridian SL-100 from the Sentinel 2000 system.

	4. Start Meridian SL-100 log routing to the Sentinel 2000 system.
	4. Start Meridian SL-100 log routing to the Sentinel 2000 system.

	5. Monitor the MSL-100 icon for alarm notification.
	5. Monitor the MSL-100 icon for alarm notification.

	6. Analyze events and alarms when notification is indicated.
	6. Analyze events and alarms when notification is indicated.

	7. Resolve alarms using a telnet session from the SPECTRUM system to the MAP terminal.
	7. Resolve alarms using a telnet session from the SPECTRUM system to the MAP terminal.

	8. Manually clear the alarms in the SPECTRUM system.
	8. Manually clear the alarms in the SPECTRUM system.



	SpectroGRAPH presents network device information from several perspectives within three hierarchi...
	SpectroGRAPH presents network device information from several perspectives within three hierarchi...

	See the SPECTRUM System User Guide for detailed information about setting up the hierarchical vie...
	See the SPECTRUM System User Guide for detailed information about setting up the hierarchical vie...

	Using the SPECTRUM system views
	Using the SPECTRUM system views
	Use SpectroGRAPH system views to create Meridian SL-100 models, monitor the MSL-100 icon for alar...
	Use SpectroGRAPH system views to create Meridian SL-100 models, monitor the MSL-100 icon for alar...

	Creating a new model of the Meridian SL-100 in a SpectroGRAPH system view
	Creating a new model of the Meridian SL-100 in a SpectroGRAPH system view
	After starting SpectroSERVER and SpectroGRAPH, use
	After starting SpectroSERVER and SpectroGRAPH, use

	Procedure�4�� Create a new model of the Meridian SL-100 in a SPECTRUM system view
	Procedure�4�� Create a new model of the Meridian SL-100 in a SPECTRUM system view
	At the SpectroGRAPH view window:
	At the SpectroGRAPH view window:
	1 Click the File menu item and select Edit.
	1 Click the File menu item and select Edit.
	A grid appears in the view background.

	2 Click the Edit menu item and select New Model.
	2 Click the Edit menu item and select New Model.
	The Select Model Type window showing a list of model types displays.

	3 Select MSL-100 from the model type list and click OK.
	3 Select MSL-100 from the model type list and click OK.
	The Creating MSL-100 window displays.

	4 Fill in the fields in the Creating MSL-100 window as shown in
	4 Fill in the fields in the Creating MSL-100 window as shown in
	<TABLE>
	Table�3�� Creating MSL-100 fields�
	<TABLE HEADING>
	<TABLE ROW>
	Field
	Description


	<TABLE BODY>
	<TABLE ROW>
	Model name:
	Enter a model name of your choice. The icon representing the switch will have the name that you e...

	<TABLE ROW>
	Network address:
	Enter the Sentinel 2000 system IP address.

	<TABLE ROW>
	RMAP Address:
	Enter the Meridian SL-100 ethernet interface unit (EIU) address. If no EIU is present, enter an I...

	<TABLE ROW>
	Community name:
	Leave supplied entry unchanged.

	<TABLE ROW>
	Location:
	Optional. Enter information for your own purposes.

	<TABLE ROW>
	Contact:
	Optional. Enter information for your own purposes.

	<TABLE ROW>
	Serial number:
	Optional. Enter information for your own purposes.

	<TABLE ROW>
	Security string:
	Unused. Leave as is.

	<TABLE ROW>
	Polling interval:
	Supplied. Denotes the frequency of the polling interval.

	<TABLE ROW>
	Log ration:
	Supplied.

	<TABLE ROW>
	Device type:
	Defaults to switch. Leave supplied entry unchanged.




	5 Click OK.
	5 Click OK.
	An icon representing the new model appears in the SpectroGRAPH universe view.

	6 Click the File menu and select Save & Close.
	6 Click the File menu and select Save & Close.
	The grid disappears and the model type icon indicates the system status.



	If the SPECTRUM system has made contact with the device since the model was created, the contact ...
	If the SPECTRUM system has made contact with the device since the model was created, the contact ...
	Figure�9�� Contact status label display example
	Figure�9�� Contact status label display example
	<GRAPHIC>



	Connecting to the Meridian SL-100 from the Sentinel 2000 system
	Connecting to the Meridian SL-100 from the Sentinel 2000 system
	The next step after creating an Meridian SL-100 switch model in SpectroGRAPH is to establish a ho...
	The next step after creating an Meridian SL-100 switch model in SpectroGRAPH is to establish a ho...

	Procedure�5�� Connect to the Meridian SL-100 from the Sentinel 2000 system
	Procedure�5�� Connect to the Meridian SL-100 from the Sentinel 2000 system
	At the Sentinel 2000 system login window:
	At the Sentinel 2000 system login window:
	1 Login to the Sentinel 2000 system (either by direct terminal connection or by telnet).
	1 Login to the Sentinel 2000 system (either by direct terminal connection or by telnet).

	2 Initiate dial out to the host port connected to the Meridian SL-100 IOC port by entering:
	2 Initiate dial out to the host port connected to the Meridian SL-100 IOC port by entering:
	>js port_no
	and pressing Enter.
	where
	port_no is the port identification number (1 to 4).
	Note:�� At this point, you can send AT commands to the Meridian SL-100 modem.
	Note:�� At this point, you can send AT commands to the Meridian SL-100 modem.


	3 Test the modem response by entering:
	3 Test the modem response by entering:
	>AT
	and pressing the Enter key.
	OK displays.

	4 At the prompt, enter the appropriate modem commands to dial the Meridian SL-100 IOC port.
	4 At the prompt, enter the appropriate modem commands to dial the Meridian SL-100 IOC port.
	On the Meridian SL-100 MAP terminal window, the port state displays Disc until the Sentinel 2000 ...
	On the Sentinel 2000 system host session display, Connect 9600 is displayed indicating the connec...




	Starting Meridian SL-100 log routing to the Sentinel 2000 system
	Starting Meridian SL-100 log routing to the Sentinel 2000 system
	The purpose of
	The purpose of

	After the Sentinel 2000 system communication with the Meridian SL-100 is established, use the MAP...
	After the Sentinel 2000 system communication with the Meridian SL-100 is established, use the MAP...


	Monitoring the MSL-100 icon for alarm indications
	Monitoring the MSL-100 icon for alarm indications
	You are ready to monitor the MSL-100 icon displayed in the SpectroGRAPH view for alarms and event...
	You are ready to monitor the MSL-100 icon displayed in the SpectroGRAPH view for alarms and event...

	Use
	Use
	Note:�� If the icon is any color other than green, or if the icon is blinking, diagnose and resol...
	Note:�� If the icon is any color other than green, or if the icon is blinking, diagnose and resol...


	Procedure�6�� Monitoring events and alarms in SpectroGRAPH
	Procedure�6�� Monitoring events and alarms in SpectroGRAPH
	At the SPECTRUM view window:
	At the SPECTRUM view window:
	1 Use the right mouse button to click the icon representing the Meridian SL-100 switch to access ...
	1 Use the right mouse button to click the icon representing the Meridian SL-100 switch to access ...
	The Alarms manager window displays showing information about the alarms. Use this information to ...

	2 Examine the events information tab for a selected alarm in the alarm manager.
	2 Examine the events information tab for a selected alarm in the alarm manager.
	Note:�� The tab labelled “Events” contains detailed alarm information including the original Meri...
	Note:�� The tab labelled “Events” contains detailed alarm information including the original Meri...


	3 Close the Alarms manager by clicking the window close bar or clicking the File menu item and se...
	3 Close the Alarms manager by clicking the window close bar or clicking the File menu item and se...



	Actual Meridian SL-100 maintenance functions must be accomplished using a MAP terminal. After you...
	Actual Meridian SL-100 maintenance functions must be accomplished using a MAP terminal. After you...


	Resolving alarms using a telnet session from the SPECTRUM system to the MAP terminal
	Resolving alarms using a telnet session from the SPECTRUM system to the MAP terminal
	Use
	Use

	Procedure�7�� Resolve alarms using a telnet session from the SPECTRUM system to the MAP terminal
	Procedure�7�� Resolve alarms using a telnet session from the SPECTRUM system to the MAP terminal
	At a SpectroGRAPH view:
	At a SpectroGRAPH view:
	1 Double click the center of the MSL-100 icon or use the right mouse pull-down menu to select the...
	1 Double click the center of the MSL-100 icon or use the right mouse pull-down menu to select the...
	A telnet window displays the MAP terminal login.
	Note 1:�� If you entered the Meridian SL-100 EIU address in the Model Creation window RMAP Addres...
	Note 1:�� If you entered the Meridian SL-100 EIU address in the Model Creation window RMAP Addres...

	Note 2:�� If you entered some other IP address in the RMAP Address field, the telnet window is po...
	Note 2:�� If you entered some other IP address in the RMAP Address field, the telnet window is po...


	2 Diagnose and resolve all Meridian SL-100 alarms reported in the SPECTRUM alarm events informati...
	2 Diagnose and resolve all Meridian SL-100 alarms reported in the SPECTRUM alarm events informati...

	3 Logout of the MAP terminal and disconnect the telnet session.
	3 Logout of the MAP terminal and disconnect the telnet session.




	Manually clearing alarms in the SpectroGRAPH alarms manager
	Manually clearing alarms in the SpectroGRAPH alarms manager
	Use
	Use
	Note:�� Clearing several alarms at the same time requires a relatively long time period. For this...
	Note:�� Clearing several alarms at the same time requires a relatively long time period. For this...


	Procedure�8�� Manually clear alarms in the SpectroGRAPH alarm manager
	Procedure�8�� Manually clear alarms in the SpectroGRAPH alarm manager
	At the SpectroGRAPH view:
	At the SpectroGRAPH view:
	1 Use the right mouse button to click the center of the MSL-100 icon.
	1 Use the right mouse button to click the center of the MSL-100 icon.
	The Alarm Manager window displays.

	2 Select the alarm(s) to be cleared.
	2 Select the alarm(s) to be cleared.

	3 Click the Actions menu item and select Clear or Clear All.
	3 Click the Actions menu item and select Clear or Clear All.
	<TABLE>
	<TABLE BODY>
	<TABLE ROW>
	ATTENTION









	List of terms
	List of terms
	CI
	CI
	Command interpreter. A component in the support operating system (SOS) that functions as the main...
	Command interpreter. A component in the support operating system (SOS) that functions as the main...


	CM
	CM
	Computing module. The process and memory of a dual-plane combined core (DPCC) used by DMS SuperNode.
	Computing module. The process and memory of a dual-plane combined core (DPCC) used by DMS SuperNode.


	EIU
	EIU
	Ethernet Interface Unit. The EIU is used to provide access to the MAP terminal from third party c...
	Ethernet Interface Unit. The EIU is used to provide access to the MAP terminal from third party c...


	ETAS
	ETAS
	Emergency technical assistance service.
	Emergency technical assistance service.


	GUI
	GUI
	Graphical user interface.
	Graphical user interface.


	IOC
	IOC
	Input/output controller. A level in the maintenance and administration position (MAP) terminal. A...
	Input/output controller. A level in the maintenance and administration position (MAP) terminal. A...


	LAN
	LAN
	Local area network. A network that permits the interconnection and intercommunication between mul...
	Local area network. A network that permits the interconnection and intercommunication between mul...


	LIU7
	LIU7
	Common channel signaling 7 (CCS7) link interface unit (LIU7). A peripheral module that processes ...
	Common channel signaling 7 (CCS7) link interface unit (LIU7). A peripheral module that processes ...


	LPP
	LPP
	Link peripheral processor. The DMS SuperNode equipment frame or cabinet that contains two types o...
	Link peripheral processor. The DMS SuperNode equipment frame or cabinet that contains two types o...


	MAP
	MAP
	Maintenance and administration position. A group of components that provides a user interface bet...
	Maintenance and administration position. A group of components that provides a user interface bet...


	MIBS
	MIBS
	Management information base structure. Structure used to define data management by Simple Network...
	Management information base structure. Structure used to define data management by Simple Network...


	MS
	MS
	Message switch. A high-capacity communications facility that functions as the messaging hub of th...
	Message switch. A high-capacity communications facility that functions as the messaging hub of th...


	NIU
	NIU
	Network interface unit. A peripheral module that provides the interface between an LIU7 in an LPP...
	Network interface unit. A peripheral module that provides the interface between an LIU7 in an LPP...


	OM
	OM
	Operational measurement. The hardware and software resources of the DMS-100 family switches that ...
	Operational measurement. The hardware and software resources of the DMS-100 family switches that ...


	SNMP
	SNMP
	Simple Network Management Protocol. A standard network management protocol developed by the Inter...
	Simple Network Management Protocol. A standard network management protocol developed by the Inter...


	TCP/IP
	TCP/IP
	Transmission control protocol/internet protocol. A collection of network protocols referred to as...
	Transmission control protocol/internet protocol. A collection of network protocols referred to as...


	TTP
	TTP
	Trunk test positions. A maintenance and administration position (MAP) terminal specially equipped...
	Trunk test positions. A maintenance and administration position (MAP) terminal specially equipped...
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